logue, a cost of 0 indicates that units of a particular
class cannot move into this terrain at all.

Designing the Scenarios

When the unit classes and terrain have been de-
signed, you can move on to the scenarios them-
selves by selecting Scenario Editor from the Editor
menu. The scenario editor screen shows the de-
scription editor, flanked by a scenario selector and
the Map button.

The scenario selector allows you to select
which scenario to edit, numbered from O to 15.
New games always start at scenario 0, but beyond
that you control the order.

The description editor works like the descrip-
tion editors for unit classes and terrain. There are a
number of other settings for each scenario that are
accessed from the Scenario menu.

Resources allows you to specify the starting
resources and the income
per turn for this scenario.
This applies to both play-
ers, though the figure is
irrelevant for players who
cannot create or repair
anything.

Scenario Hllustration 3: the terrain type editor.

sequence... brings up a

dialogue to specify which scenario is to be played
next. You can have the campaign branching in dif-
ferent directions depending upon who wins a par-
ticular scenario.

Options... allows you to specify who can do
what in this scenario. While you can prevent a
player from creating and restoring units simply by
giving him no units that are capable of doing either,
this dialogue allows more fine tuning: for example,
you could allow one player to build units while the
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other may only repair. Capture positions allows
you to create a siege, where one player can win by
capturing the victory positions, while the other
player must defend those positions and annihilate
the attacker.

The most interesting part of this exercise is
the map editor, accessed using the Map button.
This allows you to plot terrain, units and victory
positions, any of which can be chosen using the se-
lector at the bottom left. The last item you can
choose with this selector is marked marked X: this
is the deletion tool, which allows you to delete units
and victory positions from the map.

Saving and Changing

When you have finished editing your campaign,
choosing Close on the File menu saves it and return
to the title screen, allowing you to play test your
creation. To make fur-
ther changes to your cam-
paign, choose the Edit

campaign option from

the Campaign menu.

To distribute your

campaign to other people
you must send both the
campaign file, named as
you specified when you created it, and the associ-
ated graphics file, which has the same name but
with .mbm added. To work with The World at
Strife a campaign file must always be accompanied
by the associated graphics file.

New campaigns for the game will be posted
on its web site—see the game's Readme.txt file for
the address. Third party campaign files are wel-
come, so if you have created a masterpiece, by all
means send it in!
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Thank you for downloading The World at Strife! This manual contains three sections: Instructions for in-

stallation, for playing and for creating campaigns.

INSTALLATION

The World at Strife is compatible with the following
EPOC32 machines: the Psion Revo, Revo Plus,
Series 5, Series Smx, Series SmxPro, Series 7, net-
Book, netPad, the Oregon Scientific Osaris, the
Geofox One, the Ericsson MC218, the Diamond
Mako and the PsiXpda.

The game is supplied as a single SIS file for
all models. You can install this directly on the
EPOC device, or by using PsiWin. During the in-
stallation process you are asked which graphics file

to install. Be sure to answer Yes when asked about
the graphics for your particular machine. Other-
wise The World at Strife cannot run!

The Wstrife icon then appears on the Extras
bar. The first time the game is run after installa-
tion, users of the Oregon Scientific Osaris should
disable sound using the Preferences option on the
Tools menu. The Osaris does not support sampled
sound playback and trying to enable it may cause
unpredictable results.

PrayinG A GAME

Four campaigns are supplied with The World at
Strife. The first time you play, you are asked which
one to load. Later you can choose another one to
play using Open campaign... from the Campaign
menu. When your chosen campaign is selected, tap
on the Play button.

You are first asked who will play each side:
Human, or Computer (Easy, Average or Hard).
Easy computer players tend to inflict less damage
in an attack than human players. Average computer
players inflict the same while hard computer play-
ers tend to inflict more. Once the players are
chosen, the introduction to the first scenario ap-
pears.

The campaign is split into scenarios, up to
sixteen in all. The order in which the scenarios are
played depends upon the campaign and is some-
times influenced by the results of each battle. Each
scenario starts with an introduction, at which point

you can save the game. When you have read the in-
troduction, tap Play to start the battle.

Moving Units

Controls during the battle are simple (see Illustra-
tion 1). Tap twice on a unit to select it. Tap twice
on an empty square or an enemy to move your cur-
rent unit towards it. Tapping once on any unit or
square changes the status area at the bottom left
into a button, usually /nfo but sometimes Create or
Restore, depending on the circumstances. Info,
Create and Restore are also available from the
menus; the button is simply for convenience.
Tapping on the status area when it is not
showing a button toggles between the unit type
name and the statistics display. The statistics dis-
play has two indicators: the upper one shows the
current unit's health, and the lower one shows how
much movement remains to it this turn. Movement



is restored each turn, but health is only restored us-
ing the Restore option.

Creating and Restoring Units

The availability of the Create and Restore options
depends on the campaign. To create a new unit on
the battlefield, select a unit that is capable of creat-
ing others. Then tap once on an adjacent empty
square and the Create button appears. Tapping on
the button brings up the unit selection screen on
which you can read about the unit types and select
one to crerate. Once chosen, the new unit should
appear on the battlefield. If anything prevents the
creation of this unit, a brief explanatory message
appears.

Restoring units is similar. The unit must be
adjacent to one which can restore it. Select the unit
that does the restoring then tap on the damaged
unit. The Restore button appears. Tap on the Re-
store button and the dam-
aged unit should return to
full strength. An error
message briefly appears
if this is not possible for
some reason.

Help and Settings

Context-sensitive help is

always available. At most places, selecting Help
from the Tools menu brings up a brief help page
about the current screen.

The Info function has been described already.
It can do more than show information on the cur-
rent unit or map square, however. At the bottom
left after tapping Info there is an icon with arrow
buttons either side. When looking at a unit, tapping
on arrow buttons allows you to browse all the unit
types. When looking at terrain, the terrain types
can be similarly examined.

The Tools menu also contains the Preferences
option. This allows you to alter the game settings.
Two settings are available: Sound and Path finding.
Sound should be self-explanatory. Path finding af-
fects how your units find their way to their object-
ives. The Slow/intelligent setting can find its way
around any obstacle but takes considerable time to
work out the best route. The Quick/stupid setting is

Hllustration 1: moving units on the battlefield.

much faster but can only find its way around simple
obstacles. Experiment to find which suits you best.
Computer players always use the Slow/intelligent
setting.

Detail on Units and Terrain

Units are described by a number of attributes: hits,
power, range, armour, movement and cost. These
are explained as follows:

Hits is the amount of damage a unit can take
over time before it is destroyed. The Info screen
shows a unit class's initial hits, but individual units'
hits are reduced as they take damage. The status in-
dicator shows a unit's current state.

Power is the maximum amount of damage a
unit can cause in a single attack. Each attack
causes at random an amount between 0 and this fig-

ure.

Range is the range in map squares at which a
unit can fire.

Armour is  the
maximum amount of
damage a unit can absorb
in an attack without af-
fecting its hits. From
each attack the armour

absorbs at random an
amount of  damage
between 0 and this figure. In this context the term
armour may represent other protective capabilities
such as a shield, ECM, or even a better than average
manoeuvring ability.

Movement is the distance that a unit can move
in a turn over optimal terrain. Note that attacking
an enemy uses up all of a unit's remaining move-
ment points for that turn.

Cost is the cost of creating the unit, where
this facility is available. A unit can be restored to
full strength for half this cost.

The meaning of the terrain attributes are as
follows:

Defence is the chance, expressed as a percent-
age, that the terrain will absorb all of the damage
from an attack against it. For example, half of all
attacks on average fail to reach a target hiding in
terrain with a defence of 50.

The movement cost table expresses for each

unit class how many movement points it costs for
that unit to move into this type of terrain. A cost of

zero (usually shown as a dash) means that the unit
cannot enter this type of terrain.

CRrEATING A CAMPAIGN

As well as playing the four supplied campaigns,
The World at Strife allows you to create your own.
You can access the campaign editor from the Cre-
ate new campaign... option on the Campaign menu
of the title screen. After asking for a name for the
new campaign, the program presents the unit class
editor.

Before creating the units you will probably
want to visit two options on the File menu. Edit
nation names allows you to name each side, while
Set theme... allows you to choose one of the four
supplied graphical themes—metal, plastic, stone or
wood—that your campaign will use for buttons and
other game graphics.

Creating the Units

A campaign can have up
to eight unit classes. For
each unit class you can
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draw the sprite, specify
the unit's statistics, and
write a description. From
left to right the screen
contains the following sections (See lllustration 2):
1. the unit class selector; 2. the drawing grid; 3. the
unit display; and 4. the colour selector.

To draw a unit, simply select a colour and
draw on the grid using the stylus. Transparent cells
are shown using a slant line. You are drawing the
unit for player 2; player 1's graphics are automatic-
ally generated by flipping the sprite horizontally
and changing the greys to white. Zooming in or out
toggles between two resolutions. You should sup-
ply sprites for both resolutions, in order that your
campaign can be played on all supported machines.
If all this drawing seems too much effort, you can
use the Fetch from library... option on the Drawing
menu to use one of the supplied sprites.

The lower half of the unit display contains the
unit attributes. Tapping on the name brings up a
series of dialogue boxes for specifying the name,
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Hllustration 2: the unit class editor.

the attributes, and the sounds a unit makes. The
numeric attributes can be more quickly edited using
the arrows beside each number. Finally, tapping on
the boxes at the bottom toggles which other units
this class can create or restore.

You should give a description for each unit
class, to appear when the Info option is used in the
game. To do this, select Class description from the
Editor menu. Selecting Class editor from the same
menu returns to this screen.

Editing Terrain

The Terrain Editor (see Illustration 3) is accessed
from the Editor menu, and works in much the same
way as the class editor.

T Only the differences will
be discussed here.

il When drawing
terrain there are sixteen

I
WL separate tiles. These al-
P 10w continuous terrain to

be joined together across
squares. You can edit the
terrain tiles individually, or you can use the auto
plot feature. The settings require some explanation.
Where the autoplot panel shows one circle, tiles
must be drawn individually. When two circles are
shown, pixels you draw are copied across all tiles.
But one-and-a-half setting is the most interesting
and the most difficult to explain. Pixels that you
plot are copied only to those tiles that should
match, depending on what quadrant of the grid you
are drawing in. The best way to see this at work is
to try it by drawing a circle in the first tile, with this
setting enabled. Note that each tile has beside it
two indicators: one to show which tile you are cur-
rently drawing, and one to show how this tile fits
with surrounding terrain.

Attribute editing and description editing work
in the same way as for unit classes, except that ter-
rain makes no sound. In the movement cost dia-



